
Photo2Read Tasks

Starting Photo2Read

Photo2Read can be started from the Windows start menu. Opening documents

can then be done via the File menu.

It can also be started by dragging a file or a folder to a shortcut icon of

Photo2Read placed on the desktop. In this case the menu bar is hidden. To make

it visible, press the “esc” escape key (Pressing it again hides the menu bar).

If a folder is selected all the images it contains will be viewed in sequence. The

images in a folder are seen before those in a sub-folder. The viewing sequence

starts with the first image. Selecting a file has the same effect as selecting its

enclosing folder, but the viewing sequence starts with the file selected

The Help menu has, in the “Preferences” tab, a checkbox “Scan sub folders”.

Uncheck it to prevent Photo2Read from including images from sub folders.

Terminating Photo2Read

To end using Photo2Read the user can use the Menu “File/Quit” or press the

“Quit” key (by default the “Q” key). Depending on options sets in Help

Preferences the user may be asked whether or not to save to disk the generated

icons and the bookmarks. If the bookmarks are saved to disk the page indices

that may have been created are also saved.

The Viewing modes

Zoom Fit : When photographing it is often preferable to set the photo size to

several meg pixels so that the small details are not lost when zooming. As a

result photos are usually much larger than the computer screen size.

Photo2Read proposes four viewing modes. Pressing the “Zoom Fit” key (by

default the keyboard “Z” key), toggles between resizing the images to the screen

size and viewing the image in its true size. In the latter case, the screen is used as

a track pad. Mouse cursor displacements over the computer screen allow all of

the image to be seen. The mouse speed can be adjusted to the taste of individual

user from the Windows Control Panel. A panning indicator is displayed at the

bottom right of the screen (note that is the image that moves and not the screen).

BookReading : in the bookReading mode obtained by pressing the “B” key the

images are adjusted to the size of the screen so that a column of text can be

comfortably read. Pressing one the number keys, 1, 2, 3, 4, 5 specifies that the

images of the document you read have 1, 2, 2, 3, 5, columns. Moving the image is



as in ZoomFit mode; however, when reading a long column, the user may wish to

constrain the image movements to the vertical by setting the “Caps Lock” key on.

Fit1D : The user may wish to make maximal use of the screen size to view

images. Fit1D mode adjusts the image size so that the whole image can be seen

by either vertical or horizontal mouse displacements. The “Fit1D” key (by default

the “A” key) toggles between the fit1D mode and whatever display mode was

before.

The Mouse Wheel : The mouse wheel can be used to resize the image to the user

convenience in all modes except the bookReading mode where it is made

ineffective.

Freezing the image : By pressing the “Freeze image” key (by default the “F” key)

the user can freeze or unfreeze the current image view. As a result the image

does not move in response to mouse moves. This can be useful to liberate the

cursor to move over any part of the image currently seen, as when explaining

something to someone.

Image capture : Pressing the “Capture screen region” key (by default the “R” key)

the image currently on view freezes and by clicking the mouse the user can

define a portion of the current image view that is captured to the Windows

Clipboard. At the same time the Photo2Read main window is reduced to a small

size and dragged anywhere on the screen. Then the user can open any software

(MS Word, PowerPoint, MS Paint, any graphic editing software) to receive the

image from the clipboard. The captured image corresponds to actual size of the

corresponding image region. Note the captured quality still need to be improved

so is not recommended for art works. It is good enough for capturing technical

text or drawings.

Image transitions:

To move to the next image, just click the mouse or press the “Right Arrow” key.

To move to the previous image, shift click the mouse or press the “Left Arrow”

key.

Moving beyond the last image takes you to the first image and moving before the

first image takes you to the last image. These transitions are accompanied by a

beep sound that can be eliminated by unchecking a box in the Help Preferences.

A slide show of images (in whatever viewing mode you selected) can be obtained

be pressing the “Slideshow” key (by default the “S” key). When the shit key is

down, the slideshow goes backwards. The slideshow is stopped by pressing the



Slideshow key again. The default duration an image is displayed is set by default

in the Help Preferences tab. While viewing a slideshow, it can be accelerated (de-

celearated) by pressing the Down (Up) arrow key. The new display duration (in

thousands of a second) is displayed briefly on the bottom left of the screen.

When in slideshow mode a red dot is displayed at the bottom left of the screen.

Display Indicators

Display Indicators provide feedback to the user actions. The cursor can be made

invisible or visible by pressing the “Cursor visibility” key (by default the “C” key).

The Panning indicator can be hidden or made visible par pressing the “Panning

indicator” key (by default the “P” key). It is always hidden when the image actual

size is smaller than the screen.

The Display status indicator indicates the current image viewing mode. It is

usually displayed as a small letter at the bottom left of the screen. It can be

hidden or shown by pressing the “D” display status key.

Page icons are small images that are can be displayed at the bottom of the

screen. When a folder is opened for the first time, icons of the images found are

created (in a different process so that the user can start viewing the images

before all the icons are created). When Photo2Read is terminated, users are

asked if they want to save the icons to disk. If yes, the icons are saved in a new

folder “A Photo2Read Data” placed in the folder the user opened. The next time

the folder is opened with Photo2Read, the icons are retrieved nearly immediately.

Also retrieved are any page indexing the user has done.

Clicking on a page icon brings you to the corresponding page, except for the

center icon surrounded by a red rectangle, that when clicked open a panel of

information about the current image on view. Note a button on the left of this

panel that can be used to index the page. On the left of the panel notice the

access path to the current image and below some facilities to define a save path

and a button to a copy of the current image to that destination. To close the panel

click anywhere.

User Modes

From the preceding, you can see that in Photo2Read there are quite a number of

user preferences to manage. To simplify this management task Photo2Read

provide three default preference mode that can be viewed and edited in the Help

Preferences tab. The “New user” preferences display by default all the indicators

described above, fit the images to the screen size. By default the “Expert user”



preferences do not display any indicator and the images are displayed at their

actual sizes. The “Current user” preferences is an additional type of preferences

to display an intermediate set of indicators, such as those used when

“BookReading”.

The user can alternate between those User modes by successively pressing the

“User modes” key (by default the “X” key).

Bookmarking images

By pressing the “Mark page” key, (by default the “K” key) the current image

location is memorized. By pressing the “Go marked page” key, (by default the

“O” key) the user is brought back to that page.

For longer term bookmarking, the current page can be bookmarked as an image

icon by pressing the “Bookmark current image” key, by default the “V” key).

By pressing the “View bookmarks” key, (by default the “W” key), a window opens

showing the bookmark icons. Double clicking on one of these icons brings you to

the corresponding image. The icons in that window can be rearranged by

dragging them for a sufficient distance (Currently the rearrangement is not saved

between sessions). The icon menu in that window makes it possible to delete

unwanted bookmarks. Right Clicking on a bookmark deletes it. An option in the

Help Preferences tab activates the possibility to save the bookmarks when

quitting Photo2Read.

When the cursor is over a bookmark icon, its corresponding file path is displayed

at the top of the window. To change that to a name or description of your choice,

click on the icon to select it and then click on the button “Rename Selected Icon:”

to enter the new text in a text field. Now hovering the cursor over that icon,

displays the text you entered.

Indexing documents

In the context of Photo2Read, indexing means assigning a page number to an

image. When the document has page numbers, it would be nice to be able to use

the page contents and subjet index of the document if it has any, to be able to

jump directly to a particular page, from the content or index. In Photo2Read,

indexing is done by successive approximations. Suppose your document has

pages 1 to 300. To index these pages, go to the page 1 and index it with number

1; then go to page 300 and index it with 300. Now suppose you want to go to

page 131. Press on the “Jump to” key (by default the “J” key) and you will be led



to a page obtained by interpolation. If the sequence of images contains all the

pages from 1 to 300, then the page you will be led to will be exactly page 131.

If some pages are missing, only a few transitions to that page will be necessary.

To improve future searches, it is not much work to index page 131. As you can

see, this approach of indexing by successive approximations avoids the tedium

of precisely indexing a document, ahead of actually using these indices.

Tree View

The TreeView facility displays in a separate window all the files of a view

sequence, that preserves the folder hierarchy in which they may be. To access it

press the “TreeView” key (by default the “T” key). To omit some files or folders

from the view sequence, uncheck the corresponding check boxes. When the

cursor is dragged over a file name, the corresponding icon is displayed. A default

icon is displayed if the icon has not been generated yet. Notice on top, a progress

bar indicating the progression in icons creation. Double clicking on a file name

brings you to the corresponding image.

Use of Help

The Help window can be opened from the Help menu. It can also be opened (or

closed) by pressing the Help key (by default the “H” key).

The “Most Important!” tab is just to remind users of keyboard keys that are an

absolute must.

The “Keyboard keys” tab, gives a summary of all the keyboard key actions. You

can change the default behavior of a keyboard key by dragging its letter over

another letter. You are asked if you want to do the exchange. To render the

changes effective, quit and restart the Photo2Read application.

To view details of a particular key actions, just move the cursor over the

corresponding letter key.

The “Preferences” tab display modifiable user options. The radio buttons on top

enables the user to select default settings when starting Photo2Read.

The all user preferences apply to all setting preferences above. The reset button

reset all preferences to factory settings, including the key action preferences. The

“Save Preferences” button appears when any preference setting has been

changed.



The “File Filters” tab sets options how files are selected for viewing. By default

the “Apply Filters” checkbox is unchecked, meaning that all the images with type

extensions checked below will be included in the viewing. Check this box if you

want to filter files by dates and/or by sizes.

The “Tasks info” tab shows the page you are currently viewing. This page can be

printed as unformatted text.

The “Introductory infos” tab explains why you may want to use Photo2Read.

Saving files

You may want to save copies of some of the images you are viewing in another

directory (Click on button “New” to create a directory). To do that, make the icons

visible at the bottom of the screen. Click on the highlighted center icon. In the

panel that opens, specify on the left the directory where to save the current image

and then click on the button “Save Image”.


